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Systems biology



Flux balance analysis in metabolic networks.

1.Metabolic networks
“Metabolism is the process involved in the maintenance of life. It 

is comprised of a vast repertoire of enzymatic reactions and 
transport processes used to convert thousands of organic 
compounds into the various molecules necessary to support 
cellular life” Kenneth et al. 2003

2. Flux Balance Analysis

http://bill.srnr.arizona.edu/classes/182/CitricAcidCycle-LowRes.jpeg

http://images.google.com/imgres?imgurl=http://www.cs.unc.edu/~walk/models/double_eagle/pieces/
pipes.jpg&imgrefurl=http://www.cs.unc.edu/~walk/models/double_eagle/pieces/
&h=1095&w=1156&sz=307&tbnid=1C0069trx90J:&tbnh=142&tbnw=150&hl=en&start=1&prev=/
images%3Fq%3D%2Bpipes%2B%26hl%3Den%26lr%3D



Plan 
I) Creating an in silico model in order to describe an 

organisms metabolism in steady state

II) Connecting in silico  model to in-vivo 
experiments in e. coli  Schilling et al.  (2000)Segre` et al. (2002)



Motivation for studying metabolic 
pathways

 Better understanding of cellular physiology.
 Understanding vulnerabilities of unicellular 

metabolism.
 Manipulation, Bio-Engeneering



Constructing the model…
Step (I) - Definitions

We begin with a very simple imaginary metabolic network represented as a directed graph:

Vertex - substrate/metabolite 
concentration.

Edge - flux (conversion mediated by 
enzymes of one substrate into the 
other)

Internal flux edge

External flux edge

How do we 
define a 

biologically 
significant 

system 
boundary?



(II) - Dynamic mass balance

dx
S v

dt
 

Stoichiometry 
Matrix 

Flux vectorConcentration 
vector



(II) - Dynamic mass balance

dx
S v

dt
 

Stoichiometry 
Matrix 

Flux vectorConcentration 
vector Problem …

V=V(k1, k2,k3…) is actually a function of 
concentration as well as several kinetic 
parameters.

it is very difficult determine kinetic parameters 
experimentally. 

Consequently there is not enough kinetic 
information in the literature to construct the 
model.Solution !

In order to identify invariant characteristics of 
the network we assume the network is at 
steady state.



 (III) - Dynamic mass balance at steady state

1. What does “steady state” mean?

2. Is it biologically justifiable to 
assume it?

3. Does it limit the predictive power of 
our model? 

4. Most important question…

“The steady state approximation is 
generally valid because of fast 
equilibration of metabolite 
concentrations (seconds) with 
respect to the time scale of 
genetic regulation (minutes)” – 
Segre 2002

Yes…



dx
S v

dt
  0 S v 

4. Why does the steady state assumption help us solve our 
problem?

Steady state 
assumption 

0

0

0

 
 
 
 
 



(VI) adding constraints

0,iv i Constraints on internal fluxes:

0jb 
Constraints on external fluxes:

Source  

Sink 

Sink/source       is unconstrained

In other words flux going into the system is considered 
negative while flux leaving the system is considered 
positive.

Remark: later on we will impose further constraints 
both on the internal flux as well as the external flux…

0jb 

jb



(V) Flux cone and metabolic capabilities

Observation: the number of reactions considerably 
exceeds the number of metabolites0 S v 

0

0

0

 
 
 
 
 

The S matrix will have more columns than rows

The null space of viable solutions to our linear set of 
equations contains an infinite number of solutions.

“The solution space for any system of linear 
homogeneous equations and inequalities is a convex 
polyhedral cone.” - Schilling 2000

C

Our flux cone contains all the points of the null space 
with non negative coordinates (besides exchange fluxes 
that are constrained to be negative or unconstrained)

What about the constraints?



(V) Flux cone and metabolic capabilities

What is the significance of the 
flux cone?

 It defines what the network can 
do and cannot do!

 Each point in this cone represents a flux 
distribution in which the system can 
operate at steady state.

 The answers to the following questions 
(and many more) are found within this 
cone:

 what are the building blocks that the network can manufacture? 
 how efficient is energy conversion?
 Where is the critical links in the system?



(VI) Navigating through the flux cone –
using “Extreme pathways”

Next thing to do is develop a way to describe and interpret any location 
within this space. 

 We will not use the traditional reaction/enzyme based perspective

 Instead we use a pathway perspective:

Extreme rays - “extreme rays correspond to 
edges of the cone. They are said to generate 
the cone and cannot be decomposed into non-
trivial combinations of any other vector in the 
cone.”- schilling 2000

Differences

 Unlike a basis the set of, extreme 
pathways is typically unique

 Any flux in the cone can be described 
using  a non negative combination of 
extreme rays.

We use the term Extreme Pathways when 
referring to Extreme rays of a convex 
polyhedral cone that represents metabolic 
fluxes 

What is the 
analogy in linear 

algebra?



(VI) Navigating through the flux cone –
using “Extreme pathways”

,
1

{ |  0 }
k

i i i
i

C v v w EP w i


   
Pw v

 Extreme Pathways will be denoted by vector EPi (0≤ i ≤ k)

 Every point within the cone can be written as a non-negative linear 
combination of the extreme pathways. C v

In biological context this means that :

any steady state flux distribution can be represented by a 
non-negative linear combination of extreme pathways.



The entire process from a bird’s eyes
Compute steady 

state flux 
Convex 

Identify Extreme 
pathways (using 

algorithm presented in 
Schilling 2000)

+ constraints



 

Lets look at a specific vector  v’ :

Example
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Is v inside the flux cone?
Easy to check…

1. Does v fulfill constraints?

2. Is v in the null space of Sv=0 ?



(I) Narrowing the steady state flux cone

 The steady state flux cone contains an infinite flux 
distributions!

 Only a small portion of them is physiologically feasible. 

 More constraints on the external fluxes.

These depend on factors as:
 Organism
 Environment and accessibility substrates 
 maximum rates of diffusion mediated transport
 Etc…



(II) Calculating optimal flux distribution

 The constrained flux cone in E.coli contains ~10^6 (Schilling 
2001)

 How can we identify a “biologically meaningful” flux? 

Assumption… 

the metabolic network is optimized with respect to 
a certain objective function Z. 

Z will be a linear function. Later, we will deal with how exactly to choose Z



Minimize/Maximize                   such that     + inequality constraints

What we want to do is find the vector v in the flux cone which 
maximizes Z.

This optimization problem is a classical linear programming (LP) problem that 
can be solved using the simplex algorithm. W. Wiechert . Journal of biotechnology(2002)

j jj
Z c v 0S v 

…this can be can formulated as an optimization problem: 

























(III) How to choose the objective function Z

We want to choose a Z that is biologically meaningful. 
Reasonable options could be:
1. Z: Cellular growth (maximization)
2. Z: Particular metabolite engineering (maximization)

3. Z: Energy consumption (minimization)

We want a v that:
(A) Resides in side the cone.
(B) maximizes Z=B+D+2E.

Example:
cellular growth is correlated with the 
production of B,D and 2E. 



1. “It has been shown that under rich growth conditions (i.e. no lack of 
phosphate and nitrogen), E. Coli grows in a stoichiometrically optimal 
manner.” (Schilling 2001, Edwards 1994)

We shall use Z which reflects: 

Cellular Growth

(III) How to choose the objective function Z

2. “It is reasonable to hypothesize that unicellular organisms have evolved 
toward maximal growth performance.” (Segre, 2002.)







From: https://www.ncbi.nlm.nih.gov/pmc/articles/PMC10383060/pdf/metabolites-13-00855.pdf

Workflow for context-specific genome-scale metabolic reconstructions using multi-omics data



OptFlux demo
 # 1st time installation
 mkdir ~/tools
 cd ~/tools
 cp /home/reczko/ecoli1633.xml .
 wget http://genomics-lab.fleming.gr/fleming/uoa/vm/OptFlux-3.3.0-linux-x64-installer.run

 
 chmod u+x OptFlux-3.3.0-linux-x64-installer.run

 ./OptFlux-3.3.0-linux-x64-installer.run
 # accept the license, click ‘run after installation’, don’t accept the update options

 # run again after installation

 cd ~/OptFlux-3.3.0
 ./optflux.sh 

 # Full tutorial at: http://www.optflux.org/wiki/tutorial/TutorialOptFlux3.pdf
 Or at https://web.archive.org/web/20240619164025/http://www.optflux.org/wiki/tutorial/

TutorialOptFlux3.pdf

http://www.optflux.org/wiki/tutorial/TutorialOptFlux3.pdf


File → New Project → OptFlux model repository → Next

If repository server is unavailable, load sbml as on the next slide:



File → New Project → SBML Level 2 and below → Next



Browse model



Simulation → Wild type



Results at Simulations → WT Simulation



File → Create → Environmental conditions...

Lower Bound → 0.0 → Add Reaction Constraint → Ok



Simulation → Wild type → Check ‘Use Environmental Conditions’ → Ok

Compare Consumption,Production with aerobic simulation



Simulation → Kockout → Reaction/Gene

Knockout acetylglutamate_kinase,... Knockout genes that knockout R_PPCK,...



Compare Consumption,Production with WT Simulation:
no acetate production



Find optimized strain: Optimization → Evolutionary



Optimization progress (not deterministic)



Optimization result



>38800 fold increased acetate production (M_ac_e):



(IV) Phenotype phase planes-  PPP

Predicting cellular growth

X axis – Succinate uptake rate 

Observations:

Schilling 2001

Y axis – Oxygene uptake rate

Z axis - Growth rate (maximal value of the 
objective function as function of succinate and 
oxygen uptake) 

 Metabolic network is unable to utilize succinate 
as sole carbon source in anaerobic conditinos.

 Region 1: oxygen excess – this region is wasteful – 
(less carbon is available for biomass production 
since it is oxidized to eliminate the excess oxygen.)

 Line of optimality

Succin
ate

Oxygene

G
ro

w
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(IV) Phenotype phase planes-  PPP

Predicting cellular growth

X axis – Succinate uptake rate 

Observations:

Schilling 2001

Y axis – Oxygene uptake rate

Z axis - Growth rate (maximal value of the 
objective function as function of succinate and 
oxygen uptake) 

 Region 2 – limitation on both oxygen 
and succinate

 Region 3- the uptake of additional succinate has 
a negative effect. Cellular resources are required 
to eliminate excessive succinate.

Succin
ate

Oxygene

G
ro

w
th

 r
at

e



Model vs. biological experiments



Does E. coli behave according to 
optimal behavior predictions?

 E. coli was grown with malate as sole carbon source. 
 A range of substrate concentrations and temperatures were 

used in order to vary the malate uptake rate (MUR).
 Oxygen uptake rate (OUR) and growth rate were measured

.

.

.



Does E. coli behave according to 
optimal behavior predictions?

Malate/oxygen PPP

Ibarra et al., Nature 2002

1- The experimentally 
determined growth rate were 

on the line of optimality of 
the PPP !



Does E. coli behave according to 
optimal behavior predictions?

Malate/oxygen PPP

Ibarra et al., Nature 2002

Is the optimal performance on malate 
stable over prolonged periods of time?

Evolution of E. coli on malate was studied for 
500 generations in a single condition…

2- An adaptive evolution was observed 
with an increase of 19%in growth rate!

3- Same adaptive evolution was 
observed for succinate and Malate! 



Does E. coli behave according to 
optimal behavior predictions?

Same experiments were made using glycerol as sole 
carbon source
Day 0 – Sub optimal growth

Day 1-40 – evolution toward 
optimal growth

Day 40 –optimal growth

Day 60 –optimal growth (no 
change)

Why?



Considering instances where FBA 
predictions are inaccurate… MOMA

0 S v 
0

0

0

 
 
 
 
 

  What happens to the metabolism in the case of a   
mutation/genetically engineered bacteria? 

  What happens in terms of the flux cone?

0

0



Considering instances where FBA 
predictions are inaccurate…

 FBA – assumes optimality of growth 
for wild type

 This assumption is not necessarily 
correct some instances…
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Considering instances where FBA 
predictions are inaccurate… MOMA

 Is there any other objective function Z that can 
capture the biological essence of these mutations?

 Perhaps another model…

MOMA - minimization of metabolic adjustments

 [Segre, Vituk and Church 2002]



MOMA

 Relaxes the assumption of maximal optimal growth.

Wild-type 
growth

Mutant optimal 
growth

Mutant growth 
actual

FBA FBAMOMA

 a mutant is likely to display a suboptimal flux 
distribution between wild-type optimum and mutant 
optimum.

 Uses the same steady state flux cone as FBA.



How does MOMA work?

 Assumption – “Initially , the mutant 
remains as close as possible to the wild-
type optimum in terms of flux values.”

Mutant optimal 
growth

Mutant growth 
actual

Wild-type 
growth

FBA FBAMOMA



How does MOMA work?
 In other words:

MOMA searches for the flux distribution  in the 
“mutant flux space” which is closest to the optimal 
flux distribution in the “wild-type flux space”.

Mutant growth 
actual

Optimal growth 
wild type



How does MOMA work?
Formally:
Vwt – the wild-type optimal growth vector.
Vm – a vector in mutant flux space.
Find Vm which minimizes the Euclidian distance to Vwt :

2

1

( , ) ( )
n

m wt m wt
i i

i

D V V V V


 

This can be stated as a QP problem. That is, 
minimize 1

( )
2

Tf x L x x Qx  

Under a set of linear constraints.



Comparing MOMA and FBA on 
mutant strains



https://www.persistent.com/wp-content/uploads/2019/02/digital-twins-whitepaper.pdf

https://www.persistent.com/wp-content/uploads/2019/02/digital-twins-whitepaper.pdf


Microbiome and diseases

http://www.fortunejournals.com/articles/the-human-microbiome-an-emerging-key-player-in-health-and-disease
.pdf

http://www.fortunejournals.com/articles/the-human-microbiome-an-emerging-key-player-in-health-and-disease.pdf
http://www.fortunejournals.com/articles/the-human-microbiome-an-emerging-key-player-in-health-and-disease.pdf


Microbiome and diseases

● intestinal bowel disease
● diabetes
● obesity
● depression
● cardiovascular disease
● colorectal cancer
● ...



dynamic Flux balance analysis (dFBA):



Our multispecies dFBA algorithm:



▪
Mutual 
environment

Biomass Biomass



Our msdFBA algorithm:

substrate vector over time

Biomass vector over time



Our initial study: The benefit of cooperation

https://www.yannidakis.net/2010/11/yannidakis_509.html

http://www.yannidakis.net/2010/11/yannidakis_509.html

https://www.yannidakis.net/2010/11/yannidakis_509.html


The AGORA collection



AGORA, diets, human models from:
https://www.vmh.life





Patient gut microbiomes from NIH Human Microbiome Project

https://commonfund.nih.gov/hmp

via:

https://commonfund.nih.gov/hmp


DietScore definition

bm1

bm2

healthy patients before diet

diseased patients before diet



DietScore definition

bm1

bm2

healthy patients before diet

diseased patients before diet

patient before diet

patient after diet

dclosest  
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DietScore definition

bm1

bm2

healthy patients before diet

diseased patients before diet

patient before diet

patient after diet

dclosest



DietScore definition

bm1

bm2

healthy patients before diet

diseased patients before diet

patient after diet

dclosest



DietScore definition

dclosest

Dietscore = +1.0 , if all patients under diet end at a healthy patient
Dietscore = -1.0 , if all patients under diet end at a diseased patient



Time course of biomasses distances



DietScore profiles for each patient (IBD study)



DietScore distributions for IBD



Diet1           Diet2             q-value     

Mediterranean   GlutenFree        1.000000e+00

Type2Diabetes   GlutenFree        1.000000e+00

Type2Diabetes   Mediterranean     1.000000e+00

Vegetarian      AverageEuropean   9.999999e-01

Mediterranean   DACH              9.999906e-01

GlutenFree      DACH              9.999823e-01

Vegan           HighProtein       9.999762e-01

HighFiber       DACH              9.999452e-01

Type2Diabetes   DACH              9.994632e-01

Mediterranean   HighFiber         9.898656e-01

HighFiber       GlutenFree        9.871803e-01

Unhealthy       AverageEuropean   9.801268e-01

Type2Diabetes   HighProtein       9.756104e-01

Type2Diabetes   HighFiber         9.494194e-01

HighProtein     GlutenFree        9.197859e-01

Vegetarian      Unhealthy         9.075000e-01

Mediterranean   HighProtein       9.075000e-01

Vegan           Type2Diabetes     7.706096e-01

HighProtein     DACH              6.181543e-01

Vegan           GlutenFree        6.053679e-01

Vegan           Mediterranean     5.797649e-01

Vegan           DACH              2.476459e-01

HighProtein     HighFiber         2.214467e-01

Vegetarian      Vegan             8.463075e-02

Vegan           HighFiber         5.097940e-02

Diet1           Diet2             q-value    

Vegan           AverageEuropean   3.311465e-02

Vegetarian      HighProtein       1.400984e-02

HighProtein     AverageEuropean   4.169973e-03

Vegan           Unhealthy         2.347788e-04

Vegetarian      Type2Diabetes     7.943436e-05

Vegetarian      GlutenFree        2.016660e-05

Unhealthy       HighProtein       1.973406e-05

Vegetarian      Mediterranean     1.973406e-05

Type2Diabetes   AverageEuropean   1.090171e-05

GlutenFree      AverageEuropean   2.461366e-06

Mediterranean   AverageEuropean   2.435656e-06

Vegetarian      DACH              6.631672e-07

DACH            AverageEuropean   6.433142e-08

Vegetarian      HighFiber         6.081344e-09

Unhealthy       Mediterranean     2.153218e-09

Unhealthy       Type2Diabetes     1.705444e-09

HighFiber       AverageEuropean   8.125022e-10

Unhealthy       GlutenFree        4.419831e-10

Unhealthy       DACH              1.242662e-11

Unhealthy       HighFiber         5.817569e-14

Unhealthy       HighFatLowCarb    1.887379e-15

HighFatLowCarb  AverageEuropean   2.220446e-16

HighFatLowCarb  DACH              2.220446e-16

HighFatLowCarb  GlutenFree        2.220446e-16

HighFiber       HighFatLowCarb    2.220446e-16

HighProtein     HighFatLowCarb    2.220446e-16

Mediterranean   HighFatLowCarb    2.220446e-16

Type2Diabetes   HighFatLowCarb    2.220446e-16

Vegan           HighFatLowCarb    2.220446e-16

Vegetarian      HighFatLowCarb    2.220446e-16

DietScore distribution distances for IBD

similar diet pairs

different
diet pairs



Diets projected using DietScore distances for IBD



Patient microbiotas for colorectal cancer

=>  141 patient samples mapped to 167 AGORA 
species



DietScore profiles for each patient (CRC study)



Host-microbiota metabolic interactions



Diet1           Diet2             q-value    

Vegan           AverageEuropean   1.000000e+00

Vegetarian      Type2Diabetes     9.999999e-01

Mediterranean   HighFiber         9.999970e-01

Vegetarian      GlutenFree        9.999692e-01

Type2Diabetes   GlutenFree        9.985670e-01

HighProtein     DACH              9.985670e-01

Vegan           Unhealthy         5.377574e-01

Type2Diabetes   HighProtein       4.110011e-01

Unhealthy       AverageEuropean   3.391787e-01

Mediterranean   DACH              2.865635e-01

Vegetarian      HighProtein       2.285077e-01

HighFiber       DACH              9.856680e-02

Type2Diabetes   DACH              5.104035e-02

HighProtein     GlutenFree        5.104035e-02

Diet1           Diet2             q-value    
Mediterranean   HighProtein       2.683671e-02
Vegetarian      DACH              1.901759e-02
HighProtein     HighFiber         5.319388e-03
GlutenFree      AverageEuropean   4.302050e-03
GlutenFree      DACH              2.111175e-03
Vegan           GlutenFree        1.411617e-03
Vegetarian      AverageEuropean   4.003242e-04
Vegetarian      Vegan             1.155049e-04
Type2Diabetes   AverageEuropean   7.296435e-05
Vegan           Type2Diabetes     2.224698e-05
Type2Diabetes   Mediterranean     1.652751e-06
Type2Diabetes   HighFiber         3.429058e-08
Unhealthy       GlutenFree        2.055316e-08
Vegetarian      Mediterranean     4.437701e-08
Vegetarian      HighFiber         9.484192e-09
Unhealthy       HighFatLowCarb    5.485842e-09
Mediterranean   GlutenFree        5.207108e-10
Vegetarian      Unhealthy         1.150431e-10
HighProtein     AverageEuropean   4.622391e-11
HighFiber       GlutenFree        2.349831e-11
Unhealthy       Type2Diabetes     3.979927e-12
Vegan           HighProtein       1.246003e-12
DACH            AverageEuropean   1.276756e-14
Vegan           DACH              1.332268e-15
HighFatLowCarb  AverageEuropean   2.220446e-16
HighFiber       AverageEuropean   2.220446e-16
Mediterranean   AverageEuropean   2.220446e-16
HighFatLowCarb  DACH              2.220446e-16
Unhealthy       DACH              2.220446e-16
HighFatLowCarb  GlutenFree        2.220446e-16
HighFiber       HighFatLowCarb    2.220446e-16
HighProtein     HighFatLowCarb    2.220446e-16
Mediterranean   HighFatLowCarb    2.220446e-16
Type2Diabetes   HighFatLowCarb    2.220446e-16
Vegan           HighFatLowCarb    4.440892e-16
Vegetarian      HighFatLowCarb    2.220446e-16
Unhealthy       HighFiber         2.220446e-16
Vegan           HighFiber         2.220446e-16
Unhealthy       HighProtein       2.220446e-16
Unhealthy       Mediterranean     2.220446e-16
Vegan           Mediterranean     2.220446e-16

DietScore distribution distances for CRC

similar diet pairs

different
diet pairs



Diets projected using DietScore distances for CRC



Microbiome simulation extensions

- add other microbiome related diseases (obesity, depression, liver cancer,…)
- online tool to generate patient msDFBA profiles
- extend to whole body metabolic models: Harvey & Harvetta

Figure from: https://www.degruyter.com/view/j/jib.2019.16.issue-1/jib-2018-0068/jib-2018-006
8.xml

Recon4imd

“infant” 
Harvey&
Harvetta

https://www.degruyter.com/view/j/jib.2019.16.issue-1/jib-2018-0068/jib-2018-0068.xml
https://www.degruyter.com/view/j/jib.2019.16.issue-1/jib-2018-0068/jib-2018-0068.xml


, 
Ines Thiele, Swagatika Sahoo, Almut Heinken, Laurent Heirendt, Maike K. Aurich, Alberto 
Noronha, Ronan M. T. Fleming, doi: https://doi.org/10.1101/255885

When metabolism meets physiology: Harvey and 
Harvetta



Visualizations by Fritz Kahn from 1922 coming to 
life

https://www.fritz-kahn.com/about/

https://www.fritz-kahn.com/about/


Conclusions

selection pressure results in optimal 
performance through evolutionary process.

This optimal performance can be predicted 
using in-silico modeling.

Unicellular evolution can be thought in terms of an iterative 
optimization procedure whose objective function maximizes the 
organisms ability to survive and proliferate. If given enough time 

(iterations) a local maxima is struck….
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BERT was trained on Wikipedia (~2.5B words) and Google’s BooksCorpus (~800M words). 
These large informational datasets contributed to BERT’s deep knowledge not only of the English language but also of our world



Motivation

More than 2 articles published in biomedical journals every minute!

● Make sure this knowledge is used to the benefit of patients
● Need to make it accessible to biomedical experts
● Automated answering of questions based on semantics
● Benchmarking these systems can achieve a multiplying effect 126



BioASQ: Biomedical Semantic Indexing and Question Answering

- BioASQ initiated 2012 an annual challenge on biomedical semantic 
indexing and question answering (QA).

● Participants are required to compose informative answers to biomedical 
natural language questions.

● Includes tasks on question answering, summarization, entity detection, 
and more

● Funded by the EU and co-organized by several research institutions and 
companies

● Provides benchmark datasets, evaluation metrics, and prizes
● Attracts participants from various domains, such as NLP, ML, IR, and 

bioinformatics
● The best indexing system is now used by NIH to assign MeSHterms
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BioASQ Dataset

The development dataset consists of biomedical questions in English, along 
with their gold concepts, articles, snippets, RDF triples, "exact" answers, 
and "ideal" answers in JSON format
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Question-Answer pairs example
Question Answering models can retrieve the answer to a question from a given 
text, which is useful for searching for an answer in a document.
  

129

Question 

Can losartan reduce 
brain atrophy in 
Alzheimer’s disease? Answer

No

Context
12 months of treatment with losartan 
was well tolerated but was not 
effective in reducing the rate of brain 
atrophy in individuals with clinically 
diagnosed mild-to-moderate 
Alzheimer’s disease. [PMID: 
34687634]



General Question Answering System

130

Question

Answer

Document 
Retriever

Document 
Reader

Question Answering 
System

Can losartan reduce 
brain atrophy in 
Alzheimer’s disease?

No. 12 months of 
treatment with 
losartan was well 
tolerated but was not 
effective in reducing 
the rate of brain 
atrophy in 
individuals with 
clinically diagnosed 
mild-to-moderate 
Alzheimer’s disease

Corpus of 
documents

Retriever returns 
the top N 

documents most 
relevant to the 

question

Each candidate 
document is fed 

to the reader

Reader returns 
the highest rated 

content



Using Transformers
● groundbreaking algorithm pushing the state of the art in many areas
● used in many applications like machine language translation, conversational chatbots, better 

search engines, image annotation and is the key algorithm for Alphafold2

Bidirectional Encoder Representations from Transformers (BERT)

Generative Pre-trained Transformer (GPT)

131

Encoder Decoder

 Alexander        Fleming

Who

discovered

penicillin?

Who

discovered

penicillin?



Attention in Transformers
  

132

Attention mechanism can detect all relations in input sequences



1. BERT
Bidirectional Encoder Representations from Transformers, 2018

BERT was trained on Wikipedia (~2.5B words) and Google’s BooksCorpus 
(~800M words). 
These large informational datasets contributed to BERT’s deep knowledge 
not only of the English language but also of our world

● Masked Language Model
● Next Sentence Prediction
● Transfer learning

Transformer models

=> Finetune to final task
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2. ALBERT
(Z. Lan et al. 2020)

  Factorized embedding parameterization speed

  Cross-layer parameter sharing

  Inter-sentence coherence loss / Sentence order prediction (SOP) performance

1. ELECTRA

Efficiently Learning an Encoder that Classifies Token Replacements Accurately
(K. Clark et al. 2020)

1. + 2. =  ELECTR-A-LBERT = ELECTROLBERT
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Question-Answer pairs in real abstracts

Coherent scientific text has a semantic flow, each sentence builds upon the previous



Phase 1: Retrieval

ELECTROLBERT Architecture

pretraininig

finetuning / 
classification

Phase 2: Ranking
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Evaluation: Mean Average Precision (MAP)
Mean Average Precision(mAP) is the current benchmark metric used by 
the computer vision research community to evaluate the robustness of 
object detection models.

● Calculate the confusion matrix—TP, FP, TN, FN.
● Calculate the precision and recall metrics.

         Precision=TP/(TP+FP)           Recall=TP/(TP+FN)

● Measure the average precision.

142
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ELECTROLBERT performance in BioASQ10, 2022

More details at http://ceur-ws.org/Vol-3180/paper-24.pdf



Generative Adversarial Networks (GANs)
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GANBERT

Why to use GANBERT?

• In the era of information overload, answering questions accurately is 
crucial.

• Obtaining high-quality annotated data is expensive

• Fine-tuning of pretrained Large Language Models (LLM) helps, but risks 
overfitting

• Semi-supervised technique enhances generalization capabilities using 
extensive unlabeled text data, expanding LLM scope to handle alternative 
semantic formulations
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GANs
How does it work?

• GANBERT extends BERT by incorporating unlabeled data within a 
Generative Adversial Network (GAN) framework

• Works by pitting two neural networks against each other

• generator (G) is trained to produce internal BERT representations 
resembling the distribution of unlabeled data

• discriminator (D) learns to distinguish between generator samples and 
real instances

Image based on https://www.freepik.com/premium-vector/ & https://www.clipartmax
.com/
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https://www.clipartmax.com/


GANBERT Architecture
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GANBERT hyperparameter optimization
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ELECTROLBERT & GANBERT performance in BioASQ11, 2023

Base model: embedding size 768

Large model: embedding size 1024 
pretrained for 30 million steps

GANBERT: finetuning for ~50K steps
150



Computational resources

GPU computations were offered by HYPATIA, the Cloud infrastructure 
that supports the computational needs of the Greek ELIXIR community
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https://tinyurl.com/35ka9bmz

Pick a paper to present on 13+20 January
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https://kingteeshops.com/product/artificial-intelligence-machine-learning-christmas-tree-t-shirt/

Seasons greetings with some deep bioinformatics...
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